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structures elements 

solid elements Area elements Frame elements 

Trusses  

Beams 

Dams Frames 
 slabs 

shells & domes  
weirs 

large mass  str. 
foundation 

Arch girders  

R.c.   Retaining walls 

Area element  
ثلاثة أو أربع   یصل بین سطح

  .نقط 

Solid element  
  أكثر من یصل بین مجسم 

  .أربع  نقط 
Frame element  

یصل بین  ىخط عنصر
  نقطتین

14 ver.2000  APS  
  

 APS rogram=Pnalysis Atructural S  
 وأكثرھا الإنشائیةمجال تحلیل العناصر  فيالبرامج  أفضليعتبر ھذا البرنامج من 

  یافى كالیفورن CSIوھو من انتاج شركة ، انتشارا على مستوى العالم
من حیث التعامل مع المدخلات  المستخدمة فى ھذا المجال البرامج أرقىويعتبر من 
وامرار الھیكل الانشائى للمنشآت من برنامج ة فى بیئة رسومیة سھل والمخرجات

وغیره من برامج   Excelالنتائج لبرامج التصمیم على   وإمرار (AutoCAD)الرسم 
  .قواعد البیانات

   
 
  

 
 

 
 
 

  
     
 
 
 
 

 
 
 
 
  
  

 
 
   
 
  End i 

End j  

1 2 

3 4 
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  Examples using frame elements 
  
  
  
  
  
  

 
 

 
 
 
 

  
 

     
 
 
 
 
 

  
  
  
  

 frame elements تتكون ھذه المنشآت من عناصر توصف كلھا على أنھا
 
 
 
 
 
 

 
 
 

  D-2منشات يتم حلھا فى 
plane analysis (x-z)     5 :مثلt

frames

supports

3t 

5 t/m5t 5t

Beams

5t

 10t 10t5t 

truss
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Examples using frame and area elements 
 
 
 

    
    
 
 
  
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
  

  frame elements      أنھاوكمرات توصف على  أعمدةتتكون ھذه المنشآت من 

  area elements     إنھاتوصف على والبلاطات والأساسات 
  
  
  
  

  3Dم حلھا فى منشات يت
space analysis مثل:  

  D-2منشات يتم حلھا فى 
plane analysis (x-y)     مثل: 

Beam

Beam

Beam (frame element) 

Beam

solid slab 
(area element)

solid slab 
(area element)

posts             
(frame elements) 

(area  elements) 

 (frame elements) 

Flat slab 
(Area Element)

shell
 

Columns 
 

beam

beam

cone (slab)

Raft foundation

shaft

Reinforced concrete Retaining walls
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Types of Axes: 
 

global axis 
 

local axis 
 

ھى المحاور العالمیة للمنشأ كلھ 
 XYZ)( .ولا ترتبط بعنصر معین 

  
 
  
 
 
 
 
 
 
 
 
 
 
 
 
  
 

  
 الثانيوالمحور , ولى إلى النقطة الثانیة للعنصر المحور الأول يصل من النقطة الأ

  . ايھممستولأعلى والثالث متعامد على متعامد علیه 
  

  :العالمیة قاعدة الید الیسرى  أواور المحلیة وتتبع المح
والسبابة فى اتجاه المحور الثاني ويكون المحور  الوسطي فى اتجاه المحور الأول

  .الثالث فى اتجاه الإبھام 

 local)تحلیل العناصر تكون حسب المحاور المحلیة   من المھم معرفة أن نتائج •
axis)   أناى frame elements   ھى  د التحلیل ستة نتائجيكون لھا بع:  

1- Axial force (tension +ve) , (comp. -ve) 
2- Shear 2-2 (force in direction of local axis 2) 
3- Shear 3-3 force in direction of local axis 3) 
4- Torsion (moment about local axis 1) 
5- M2-2 (moment about local axis 2) 
6- M3-3 (moment about local axis 3) 

 
 
 

ھى المحاور الخاصة لكل عنصر 
.على حده  

  احمر
  أبیض

  ازرق

z 
y

x 
global axis x-y-z 

  .لاحظ أن المحاور العالمیة لیس لھا علاقة بالمحاور المحلیة

z 
y

x
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 توصیف المنشأ-أ

    (grid lines). عمل خطوط عمل مساعدة فى الرسم  - 2

لعناصر التى سیتم لطاعات الق بالمواد و تعريف البرنامج - 3
 . استخدامھا

 .رسم العناصر بالقطاعات التى تم تعريفھا من قبل - 4

أو   joint loadsوضع الأحمال على العناصر سواء كانت  - 6
frame loads   

  (supports)وضع الركائز  - 5

 إنشاء ملف جدید  - 1

 الملف  حفظ -7

  Analysis -  run)(حل المنشأ  -ب

 النتائج  إظھار -ج 

 Z) plane:-(X خطوات التحلیل الإنشائي
Beams,frames,trusses,Arch girders,…etc  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

من  (ton-m-c)تغییر الوحدات إلى  شيء يتم قبل أي:عمل ملف جديد-1
  الشريط السفلى للبرنامج

  

  file →new modelمن قائمة  ثم
 
 
 
 
 

من  تظھر شاشة بھا مجموعة
الجاھزة التى يمكن  المنشات
  .بھا فیما بعد  الاستعانة

لفتح ملف جديد   

لفتح ملف موجود من قبل   

أو من شريط الأدوات   
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 gridsيتم اختیار ملف فارغ به مجموعة من 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

يمكن بھا عمل خطوط شبكة منتظمة على مسافات  gridsتظھر شاشة  - 2
  الاتجاھات فيمتساوية 

  x أوy  أوZ  
  

 
 
 
 
 
 

 
 
 
 

  
  
  
  
  

  
  

 xفي اتجاه  عدد خطوط  الشبكة

 yفي اتجاه  خطوط الشبكةعدد 

 zفي اتجاه  خطوط الشبكةعدد 

 xى اتجاه المسافة ف
 yفى اتجاه  المسافة

 zفى اتجاه  المسافة

 Z أول خط شبكة لـ

 X أول خط شبكة لـ
 Y أول خط شبكة لـ
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يساوى   gridsكون الشبكة غیر منتظمة فنضع عدد نشات توفى اغلب الم
عمل بتعــديل خطـوط الشبكـة علــى حسـب المـطلوب  نقوم  ثم, أصفار

right click ثم اختیار  الشاشة في بالماوسEdit grid data   فتظھر
     Modify/ show systemشاشة نختار منھا 

  
  

  :لازمة لرسم المنشأ بسھولة طوط الشبكة الخ أماكن بإدخالفیھا فتظھر شاشة نقوم     
كل   دخال وفى ھذه الحالة یتم إ  spacingالمسافات بینھا  بإدخالخطوط الشبكة  إدخالیمكن **  

  .المسافات وفى النھایة نضع القیمة صفر 
  

لكل خط  ordinatesمن نقطة الأصل  مقاسه إحداثیاتالشبكة بوضع  إدخالكما انه يمكن ** 
  .وب شبكة مطل
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نسبة الانفعال العرضي =  0.2 
  للانفعال الطولي

fc' = 0.8 fcu 

  أسم المادة

كثافة الخرسانة 
2.5 t/m3 

  x-zسیتم توصیف المنشأ فیه وھو ھنا  الذيثم يتم اختیار المستوى * 
 
 
 
 
 
 
 

  Define →Materialsتعریف المواد المستخدمة من القائمة  - 3
  

وھى خرسانة فنعطیھا أسم   4000psiونقوم بتعدیل المادة الموجودة وھى أسمھا 
concrete  ھا وندخل مقاومتfc' = 0.8 fcu  یساوى  وكذلك معایر المرونة 

Ec=14000 √fcu  وھى بأبعاد كجم وسم  ویجب تحویلھا إلى طن ومتر لإدخالھا
 fcu=250 kg/cm2والیكم مثال على خرسانة لھا  10*للبرنامج بضربھا 
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 أسم المادة

E steel  

كثافة الحديد 
7.849 t/m3 

Fyield 
Fultimate 
1.1*Fyield 
1.1*Fultimate  

   Steelونعطیھا أسم  A992Fy50المادة الثانیة وھى  Modify ونعدل
  

  
  

للكمرات  الطوليلمادة جدیدة لتعریف الحدید  Add new Materialونضیف 
 Rebarونختار النوع  Rebarوالبلاطات الخرسانیة 

 

  

4000psi     خرسانة 
A992Fy50      حدید 
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 أسم المادة

E steel=2e7 t/m2  

كثافة الحديد 
7.849 t/m3 

Fyield =36000 t/m2 
Fultimate =52000 t/m2 

1.1*Fyield 
1.1*Fultimate  

 نوع المادة

   St. 36/52مثلا ھذه القیم لحديد 
  

  
  :وذلك من قائمة  rame elementsF تعريف قطاع  -4

Define→ section properties→frame section                     
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ونختار نوع المادة فتظھر أشكال القطاعات نختار منھا   add new propertyفنختار 
  .ثم تخصیصھا بعد ذلك لمادة خرسانیة   steelما نرید كما أننا یمكن أختیار قطاعات 

  
  

  مادتھ  نوعثم ندخل الأبعاد للقطاع ونختار

ویصلح  لاستیراد قطاع جاھز من ملف
 steelـ لل

ویفضل فى  لإضافة قطاع جدید بأبعاده
  القطاعات الخرسانیة
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تم  التي  gridsـبالاستعانة بال(frame elements)رسم العناصر  -5

  .عملھا من قبل
  Drawوذلك من قائمة 

  السريع أومن شريط الأدوات
  
 
 
 
 
 
 

  تظھر شاشة نختار منھا القطاع 
 المطلوب للعنصر ثم يتم رسمه

 
  
  

  
  
  
  
  

 .لرسم عنصر بین نقطتین 

    grid lineلرسم عنصر على 

فى باكیة محصورة  bracingلرسم 
 . grid linesبأربعة خطوط من 

فى باكیة  secondary beamsلرسم 
  .محصورة بكمرات رئیسیة

mailto:eng_m_z@yahoo.com


       (Sap 2000 ver. 14) 2000شرح برنامج ساب 
 

 eng_m_z@yahoo.comمصر –امعة الزقازیق ج–كلیة الھندسة  - مدرس مساعد بقسم التصمیم الانشائى -محمود زغلل/ المھندسعداد إ         
]

types of loads 

Area loads frame loads joint loads 

     :النقطة ثم  باختیاروذلك  supports تخصیص الركائز  -6
  

  Assign → joint → Restraint   
   السريع أو من شريط الأدوات

  
  
  
  
  
  
  
  :وضع الأحمال -7

  
  
  
  
  
  
  
  
  
  
  

  
  
  

joint loads -1 
  
  

    
  
  

            
    

 
 
 
 
 
 
 
 

Settlement of supports 

x 

Z 

Py 

Px 

Mx 

Mz 

Forces Moments 

My Pz Y 
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إلى النقطة  الحمل  ويتم تخصیص* 
  :عن طريق اختیارھا ثم 

Assign→joint loads→forces 

                                   →displacements 

  
  

                                            
      أو من شريط الأدوات,                                                 

  
  
  
  
  
  

  
  

  
  

  
  
  
  
  
  

  
  
  

  
  
  

:Frame loads -2 
  

 
  
  
  
  
  
  

                             Uniform load                  trapezoidal load    
  :نختار العنصر ثم   frame elementلتوصیف حمل على 

Assign →frame loads→ point load              

Distributed load     →   
  
  

 لإضافة حمل-
 لاستبدال الحمل-

 لاحمالأ لغاءلإ-

 لإضافة حمل
 لاستبدال الحمل

 لاحمالأ لغاءلإ

P 

M 

Point loads Distributed loads 
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 لتخصیص حمل كنسبة من وزن العنصر

 صیص قوى أو عزوم مركزة لتخ* 
لتخصیص حمل موزع *    

  لتخصیص التغیر فى درجة الحرارة موزع 

Axis-1  

Axis-2 

Axis-1  

Axis-2 

local axes of frames 

X 

Z  

Global axis 

مسافة الحمل كنسبة من طول 
 من نقطة بدايته مقاسالعنصر 

من  مقاس بالمترمسافة الحمل 
 هنقطة بدايت

 ةمركز قوة عزم مركز

 نظام ألإحداثیات

 اتجاه الحمل

 مسافة الحمل

 قیمة الحمل
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 (Z–)تعنى )  (gravityلاحظ أن * 
  
  
  
  
  

  
  
  
  
  
  
  
  
  
  
  
  
  
  

  .من اتجاه الحمل  projected  نختار Horizontal  projectionلوضع حمل 
  
  
  

  File → Save     حفظ الملف من قائمة -8
  لأدوات   أو  من شريط ا       

  
  
  
  
  من قائمة الأوامر Analyze → run analysisعمل     -9

  أو من شريط الأدوات          
  
  من لوحة المفاتیح  F5أو ضغط مفتاح    
  
  
  
  
  
  

توصیف روؤس حمل 
 مثلث أو شبه منحرف

 قیمة الحمل المنتظم 

 اتجاه الحمل
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  : النتائج إظھار -10

   Display  ةوذلك من قائم           
  
  
  
  
  
  
  
  
  
  
  
  
  
  

    
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  :لحوظةم

   scale factor =-ve  فیجب وضع مقلوب shear2-2 , shear3-3البرنامج يرسم 
   Autoبدلا من 

ok cancel 

 الشكل بدون قیم إظھار

 قیمال وعلیهالشكل  إظھار

 frame elementsالقوى الداخلیة فى 

 مقیاس الرسم

deformed shape 

mailto:eng_m_z@yahoo.com


       (Sap 2000 ver. 14) 2000شرح برنامج ساب 
 

 eng_m_z@yahoo.comمصر –امعة الزقازیق ج–كلیة الھندسة  - مدرس مساعد بقسم التصمیم الانشائى -محمود زغلل/ المھندسعداد إ         
]

  

 Example:  
 
 
 
 
 
 
 
 
 
 
              

  خطوات الحل 
   :الخطوة الأولى 

  
  t,m,c إلىونضبط الوحدات   Sap2000ندخل برنامج الــ 

  
   : ثانیةالخطوة ال

  
  .يعنى شبكة رسم فقط Grid onlyفتح ملف جديد ونختار ن
  

   : لثالثةالخطوة ا
  

بالماوس بالزر الأيمن على الشاشة  ندخل عدد خطوط الشبكة أصفار ثم نضغط
  Sapacingمسافات الشبكة ونختار  لإدخال   modifyثم   edit gridونعمل 

   z =4,2,0ثم فى اتجاه     x = 6,2,8,3,0وندخل مسافات الشبكة فى اتجاه 
  .لرسم المنشأ فیه X-Zالمستوى ثم نختار  okثم 

5 t/m

5 t/m
5 ton

3 ton

5 ton

x

z

6 8

4

2

3

All sections  30x100 cm , CROSS SECTION AT BOTTOM =30X60
concrete frame
two hinged frame

2 
t/m

2
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   : رابعةلالخطوة ا

  
ونعرف مادة خرسانة  Define→ Materialsبتعريف المادة من  نقوم

fcu=250kg/cm2  

   : خامسةلالخطوة ا
  

   Define→ sections→ frameنقوم بتعريف القطاعات من 
سم  وقطاع مستطیل خرسانة  100*30ونضیف قطاع مستطیل خرسانة 

 100*30ونھايته  60*30خرسانة بدايته   nonprismaticوقطاع سم  60*30
  . I22فى    Linearونضع  I33فى   cubicونضع 

   :سادسةلالخطوة ا
  

ونختار أسم القطاع من الشاشة التى   Draw→ frameرسم العناصر من نقوم ب
  .تظھر أمامنا ونرسم به 

  
  

   :بعةلساالخطوة ا
  

لھا من القائمة   hingeالركائز ثم تخصیص نقوم بأختیار النقط التى عندھا 
Assign→ joint→ restraints  

Z 
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  والقطاعات وأرقام العناصر   local Axisلأظھار المحاور المحلیة 
 View →  set display options: من القائمة 

  أو من شريط الأدوات 
  
  
  
  
  
  
  
  
  
  
  
  
  
  

   :ثامنةلالخطوة ا
  

لھا حمل  من  عندھا أحمال مركزة  ثم تخصیص  نقوم باختیار النقط التي
  Assign→ joint loads →forcesالقائمة   

   :تاسعةلالخطوة ا
  

نقوم باختیار الكمرات  التي عندھا أحمال ثم نخصص لھا حمل موزع من القائمة 
Assign→ frame loads →distributed    

لأظھار 
العناصر 
 مجسمة

 اظھار القطاعات

 المحاوراظھار 
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  :طريقة أخرى لأدخال الأحمال على النقط والكمرات
كن الضغط على النقطة او الكمرة بالزر الأيمن بالماوس فتظھر شاشة نختار يم

  .ثم نخصص لھا الحمل الذى نريده  double clickمنھا الأحمال ونضغط علیھا 
  
  
  

  
  

  بالماوس double clickنضغط ھنا 
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  :تظھر الشاشة التالیة

  
 okوندخل قیمتھ ثم   concentratedأو    distributedفنختار نوع الحمل 

  
 deadويضیفه على حالة   (own weight)ن العناصر ب وزالبرنامج يحس: ملحوظة 

load  
  define → load patternsوذلك بعمل ويمكن أن نجعل قیمته صفر 

   self weight multiplier =0ثم عمل  
    modify load patternثم عمل   

  
  

  
  
  
  
  
  
  
  
  
  
  
  

 display showیمكن رؤیة الأحمال المركزة مع الأحمال الموزعة من القائمة  -
load assigns   ثمok   

  
   :عاشرةلالخطوة ا

  
  Analyze →Run Analysisثم عمل    saveنقوم بحفظ الملف من 

 Run/Don’t Run Caseالضغط علیھا ثم  Modalونلغى الحالة   F5أو نضغط 
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  Run nowنضغط   ثم 
  

   :حادية عشرلالخطوة ا
ند الوقوف على اى نقطة وع  deformed shapeيظھر البرنامج بعد الحل شكل 

ولرؤية الشكل قبل التشكل مع الشكل  x,y,zيظھر مسافات تحركھا فى اتجاه 
 wireونختار   Display→show deformed shapeبعد التشكل ندخل القائمة 

shadow  
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ثم   Display→show forces /stresses →framesبرؤية النتائج من القائمة نقوم 
  ونختار  shear2-2 أو   Moment3-3او   Axial forceنختار 

  Show values on diagrams القیم على الرسم لأظھار   

  
 Display→show forces /stresses→jointمن القائمة  Reactionsنقوم برؤیة الــ 

   
  

لتعديل خواص المنشأ من حیث الأحمال أو الأبعاد بعد حل المنشأ يجب فتح *** 
  .مرة أخرى  Runمل ثم التعديل ثم ع                        القفل

  
 

Home Work: 
 
 
  
  
  
  
  
  
  
  
  

  
  
  

5t 3t 3t 4t 3t 
2.5 t/m 

3 t/m 2.5t/m 
1t/m 

1.5m 4 m 6 m 1 m 4.5 m 2 m 

2 t.m 

 All beams  25x60  cm 

 beams: 1مثال 
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  :أوامر مساعدة في الرسم
    Replicate  امر التكرار للعناصر

  
  
  
  
  

  
  يتم اختیار العنصر الأصلى المراد تكراره - 1
   Edit → Replicateن القائمة م- 2
   

  
  
  
  
  
  
  
  
  

  
 
  
  

4 m 2 m 8 m 3 m 

3 m 

3 m 

1.5 m 

5t 

2t/m 

4t/m 6t 

2t/m (H.P) 

1t/m (per.) 

2t/m 
4t 

4t 

5t 

cols. 30x60 cm 
beams,cantilivers 30x80 cm 

 frames: 2 مثال

 العنصر الأصلى

 المطلوب رسمھا الجدیدة صراالعن
مسافة بین ال

 العناصر للتكرار

 للتكرار خطیا 
 االعدد المطلوب الجدید

مسافة التكرار بین العناصر فى 
   xاتجاه 

مسافة التكرار بین العناصر فى 
   yاتجاه 

مسافة التكرار بین العناصر فى 
 zاتجاه 
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  Global Axis (X-Y-Z )لأظھار وأخفاء المحاور العالمیة *
     view→ show Axisمن القائمة   
  
  gridsلأظھار وأخفاء خطوط الشبكة *
   view→ show gridمن القائمة   
  
   panمن الأداة  لتحريك الشاشة*
      view→ panأو من القائمة    
  

للتكرار فى مسار دائرى حول محور 
  معینةمعین عند نقطة  

لعمل نسخة معكوسة من العنصر حول 
  أى خط  

 إحداثیات نقطة الدوران

 الزاویة بین كل عنصرین

  لتحدید خیارات التكرار عدد العناصر  المطلوب
  للأحمال والقطاعات

 وغیره......

 طة بدایة الخط حداثیات نقإ

 طة نھایة الخط حداثیات نقإ

  لتحدید خیارات التكرار
  للأحمال والقطاعات

 وغیره......
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 zoomلتصغیر او تكبیر الرؤية على الشاشة نستخدم أدوات *
  

    
  

    
    

  
  

    
  

  zoomبھا نفس أدوات  view أو من القائمة 
    

  
  
  
  
  
  
  
  
  
  
  
  
  

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

  

على     zoomلعمل 
  منطقة معینة فى المنشأ

كلھ  المنشألأظھار 
  داخل الشاشة

لأستعادة 
 zoomآخر 

  للتكبیر

  للتصغیر

Zoom 
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  لكنھا لا تتحمل عزوم او قوى قص  framesالجمالونات ھى نفسھا 
  trussتحرير العزوم فى بداية ونھاية كل عنصر من عناصر   ولذلك يجب

  ولیست joint loadsكلھا   trussكما أنه من المعلوم ان القوى على 
 frame loads  وتصنع غالبا من الحديدsteel  

 
  
  
  
  
  
  
  
  
  
  
  
  
  
  

  الشكل الأول بقطاعات يتم تعريفھا لرسم   gridsيتم اولا عمل 
   define--- frame/cable sectionsمن القائمة 

للعناصر الرأسیة والمائلة    7x7x1 cmثم اضافة قطاعین احدھما زاوية 
  .للعناصر الأفقیة السفلیة والعلوية 5x5x1 cmوالآخر زاويتین متقابلتین 

  
  ونحن نرسم العناصر حتى نحرر لھا العزوم  pinnedمع مراعاة اختیار 

  
  

  
  
  
  

  .ويتم وضع الأحمال كما ھو موضح
  
  
  

Verticals & diagonals are L 7x7x1 cm

3t 6t 6t 6t 6t 6t 6t 6t 6t  6t 3t 

12*2=24 m 

Top and bottom members  are 2L 5x5x1 cm

1.5m 

3t  6t  

(0,0,0) 

Trusses :      الجمالونات 
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3t 6t 6t 6t 6t 6t 6t 6t 6t 6t 3t 

ويمكن يمكن  Zخط  المرآة موازى لــ 
 Xتمثیله بنقطتین لھما نفس 

  Edit – Replicate -- linearثم اختیار ھذه العناصر وعمل 
  2mمرات بمسافة  4بعدد   Xفي اتجاه 

  .لاحظ انه يتم اختیار النقط التي علیھا أحمال ترغب في تكرارھا فقط 
  :فینتج ھذا الشكل 

  
  
  
  
  
  

 Edit -- Replicate-- mirrorثم يتم اختیار الشكل وعمل    
X1=12 ,Y1=0  
X2=12 ,Y2=1 

  
  
  
  
ويتم  فیتكون المنشأ كله بالأحمال كما بالشكليتم رسم الخط الفاصل بینھما  

  .تخصیص الركائز
  
  
  
  

  
ذلك اختیار  يمكن بعدونحن نرسم فى البداية   pinnedفى حالة عدم اختیار 

 — Assignالقائمة      ثم تحرير العزوم علیھا من  framesجمیع العناصر 
frame/cable — releases/partial fixity  

  .فى البداية والنھاية M33 تحريرثم 
  

  
  
  
  
  

  
  
  
  
  
  

      
  
  

3t  6t 6t 6t 6t 6t 

(12,0,0) 
(0,0,0) 
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من القائمة  DLيساوى صفر فى حالة   self wt multiplierثم يتم وضع 
define →load patterns 

  
  
  
  
  
  
  
  
  
  

  okثم  modify load patternثم عمل 
  

   Axial force & Reactionsوالحصول على قیم   runثم عمل 
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Multi story frames 
  الإطارات متعددة الطوابق

  
 
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

  
  .طوابق 8عدد الطوابق الكلى 
  .متر  4متر و باقى الأدوار   5ارتفاع الدور الأرضى 

  
له يتم رسم الدور الأرضى أولاً ثم رسم الدور الأول علوى وتكراره بأحما

  .متر  4بمسافة تكرار قدرھا  zمرات فى اتجاه  6عدد 
   Edit--- Replicate – Linearوذلك بأختیار الدور الأول علوى ثم 

  .ويتم ادخال احمال الرياح الأفقیة يدويا
  
  

8m 8m 8m 

girders 30*80
columns 30x100

4 t/m 

4 t/m 

4 t/m 

4 t/m 4 t/m 

4 t/m 

4 t/m 

4 t/m 

4 t/m

5t5t 5t 

5t5t 5t 

5t5t 5t 

5t5t 5t 

5t5t 5t 

5t5t 5t 

5t5t 5t 

5t 5t 5t 

6t

4.5t

4.5t

4.5t

6t

6t

6t

6t
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Y
Z

X

6t/m

4t/m

5t
5t

Space frames 
 الأطارات الفراغیة

 
 

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

                                                           Plan  
                    BEAMS =30X80  

 COLUMNS = 30X100           
  
  
  

  
  

3 x 8 m 

  5 m  

  4 m 

  6 m  

6m

3x8 m
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  .فى الاتجاھات الثلاثة GRIDSبادخال   X-Y-Zيتم العمل فى *
  
يتم اختیار المستوى الذى تريد الرسم فیه ثم التنقل فیه بأستخدام *

 DOWNو   UPالمفاتیح 
  
  

  
  
  
  
  
  

  
  
  
  
  
  
  
  
  
  
  
  
  

  
   Set elementsمن الاداة  Extrude viewلأظھار ضرب الأعمدة يتم اختیار نظام الرؤية 

  

  
  
  
  
  
  
  

UP 

DOWN 

    X-Zالمستوى 
 Y=0عند   

   X-Zالمستوى 
   Y=6عند   

    X-Zالمستوى 
 Y=10عند  

X 
Y 

Z 
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  :نستخدم القائمة   planثم لرؤية اسقاط قطاعات الأعمدة فى 
View → set 3d view →xy  

  تساوى صفر  Apertureونضع زاوية 
من   crossستخدام الماوس لتغییر اتجاه ضرب العمود يتم اختیاره بأو

  .الیسار الى الیمین حتى لا نختار الكمرات المتصلة به
ثم دوران محاوره حول المحور الأول بالزاوية المطلوبة وذلك من  

  :القائمة 

                                      Assign → frame/cable → Local axis  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

والنقط التي علیھا أحمال ونضعھا علیھا ثم نحل ثم نختار الكمرات 
  :ونظھر النتائج وھى تكون 

M22 ,M33,Shear22 , Shear33, Axial , Torsion 
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عة والأستادات تغطیات الصالات الواس
 الخ......والھناجر والكبارى المعدنیة 

ELEVATION  SIDE VIEW  

trusses Space  
  الجمالونات الفراغیة

  
  
  
  
  
  
  
  
  
  

                All members one angle 6x6x1 cm 
  
  
  
 

  
  

 
  
  
  
  
  
  
  

3m 3m 

2m 

Bottom PLAN   

3m 3m 3m 3m 3m 3m 

3m 3m 3m 3m 3m 

Hinged 

Roller 

5t 5t 10t 10t 10t 10t 5t 5t 
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  خطوات الحل
ونعدل الوحدات  sap2000نفتح برنامج  : الخطوة الاولى

 ton,mالى 
 file- new modelنفتح ملف جديد من : الخطوة الثانیة

  .ثم ندخل خطوط الشبكة المطلوبة  grid onlyونختار 
  فى ھذا المنشأ يمكن رسم جزء منه فقط ثم تكراره

  
  
  
  
  
  

خطوط  4عدد   xل خطوط شبكة منتظمة فى اتجاه أي إننا ندخ
عدد خطین شبكة بمسافة   yمتر وفى اتجاه   1.5شبكة بمسافات 

  متر 2خطین شبكة بمسافة   zمتر وفى اتجاه  3

  
  y=0عند  x-zفیظھر لنا خطوط الشبكة التي أدخلناھا ونختار المستوى 

2 

1.5 1.5 1.5 
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من القائمة  Angle 0.06x0.06x0.01نعرف قطاع  :الخطوة الثالثة 
Define – Frame sections  ثم نضیف قطاعAdd- Angle    
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مع مراعاة  نرسم الأربعة عناصر الأولى : الخطوة الرابعة
  :كما بالشكل التالي لتحرير العزوم  pinnedاختیار 

  
  

  Edit – Replicate-Linearثم نختار ھذه العناصر ونكررھا 
  .مرات 5دد متر وع 3بمسافة   xونكرر فى اتجاه 

  
  

نلاحظ ظھور عنصر زيادة على الیمین نقوم بإلغاؤه فیظھر 
  :الشكل التالى
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عدد مرة واحدة   yنقوم باختیار كل العناصر وتكرارھا في اتجاه 

  : متر فیظھر الشكل التالى 3بمسافة 

  
  الرأسیة    bracingثم نقوم برسم الــ

  
 5متر وعدد  3بمسافة   xثم اختیارھا وتكرارھا  في اتجاه 

  .مرات
  bracingثم نقوم برسم ال z=0عند   X-Yثم نختار المستوى 

  :السفلیة كما بالشكل 
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  bracingثم نقوم برسم الــ z=2عند   X-Yوكذلك نختار المستوى  
  كما سبق  العلوية

  

  
  

  Assign – joint-restraintثم نختار النقط الموجود عندھا ركائز ونعمل 
  .حسب نوع الركیزة  Rollerأو  hingedثم نختار 

  
ثم نقوم باختیار النقط ووضع  z=2عند   X-Yثم نظھر المستوى 
 Assign – joint loads- forcesمن   أحمال مركزة علیھا
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وذلك   Dead loadsمن حالة الـ  self weight multiplierثم نلغى 
  Define –load patternsمن القائمة 

  
  

  
  
  Axial loadsوإظھار قیم   Runوعمل   saveقوم بحفظ الملف ثم ن

  .عند الركائز Reactionsعلى العناصر وقیم الـ 
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In
ve

rte
d 

B1
2*

50

structural plan

B 12*50

B12*50

B12*50

floor height = 3 m
wall thickness = 12 cm
Assume  all beams = 25*60 cm
Except the shown cross sections .
ts= 15 cm ( note solid slab 10 to 15 cm)
This is a residential Building (LL=0.2 t/m2)
Assume floor covering = 0.15 t/m2

xY

Solid Slab floor plan   
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f Solid SlabsoAnalysis  
  

 Solid Slabs  15ھي البلاطات المرتكزة على كمرات وأعمدة تخانتھا cm) -(10   إما أن
    .تكون مستطیلة أو دائریة أو مشطورة

  
  
  
  
  
  
  
  
  
  
  
  
  

  :الخطوات
 .و البلاطاتعند أى تقاطع للحوائط أوالكمرات أ Y -Xفى المستوى   gridsیتم عمل  - 1
 defineیتم تعریف قطاع الكمرات والبلاطات التى سنحتاجھا من قائمة   - 2

Frame sections & Area sections   
  
  

              
  
  
  

Y 

X

 تعریف قطاع الكمرات 
Define frame section , 

Add rectangular 
  تعریف قطاع البلاطة 

Define Area section , 
Add shell 

  membraneالتخانة فى 
  ثابتة Bending   الــ وفى 
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 frame/cable–raw D الأمر  یتم رسم الكمرات باستخدام -3

  dummyأو وھمیة     invertedأو مقلوبة     projected سواء كانت الكمرات ساقطة             
  continuousلكل الكمرات المرسومة لتكون    divide frames ثم عمل 

 
 
 
 
 
 
 
 
 
 

ll iFویجب قبلھا اظھار  Area -drawیتم رسم البلاطات بینھا باستخدام الأمر  - 4
objects   من القائمةView →set display objects  وكذلك اظھار المحاور

 :كما بالشكل  Area local axesالمحلیة للبلاطات التى سترسم 

  
  
  .تماما   continuousعند الرسم یجب ان نراعى أن تكون البلاطات متصلة و 

  
  
  
  
  
  
  
  
  
  
  
  
  

 .لرسم عنصر بین نقطتین 

    grid lineلرسم عنصر على 

فى باكیة محصورة  bracingلرسم 
 . grid linesبأربعة خطوط من 

فى باكیة  secondary beamsلرسم 
  .محصورة بكمرات رئیسیة

    لرسم  بلاطة بأربعة نقط 

    بلاطة مستطیلة بنقطتینلرسم 

في باكیة محصورة   بلاطةلرسم 
 . grid linesبأربعة خطوط من 
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  :مثلا
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  hinged  Assign →joint → restraints  ركائز مكان الأعمدةیتم وضع ال -5
 
موضوع فیھا   deadنجد حالة واحدة اسمھا   Define load patternsتعریف حالات الأحمال من القائمة  یتم -6

self weight multiplier=1    ثم نضیف حالة  فنتركھا كما ھى لیأخذ وزن البلاطات والكمرات فى الأعتبار
 : كما بالشكل التالى     .own wtولا نضع فیھا   liveونوعھا   liveیدة اسمھا تحمیل جد

 

  
  

  : deadفى الحالة   وھى حمل الحوائط یھاالأحمال علیتم اختیار الكمرات الموجود علیھا حوائط ونضع   -7

W wall = γ brick *h wall*t wall = 1.8*2.6*0.12 = 0.6 t/m'  
  :ونضع الحمل من القائمة 

Assign →Frame loads →distributed  
 

 خطأ

 صح

  صح خطأ
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  .مع ملاحظة أن البرنامج یأخذ  وزن الكمرة من نفسھ فلا نضع وزن الكمرات 

  
 'م/طن 4الى  2كمرة السلم التى فى منسوب الدور علیھا احمال اضافیة من السلم تقریبا من :  ملحوظة ھامة جدا

متر فیكون تقریبا   4.25مثلا عندنا ھنا طول السلم كلھ   (L /2*1.2)وھى  تساوى فى حالة السلم القلبتین تقریبا 
   't/m 2.55 = 4.25/2*1.2الحمل الأضافى الذى سیوضع على الكمرات القصیرة فى السلم ھو 

 . planأما كمرة نصف الدور فھى اصلا غیر مرسومة فى ھذا الــ 
  
ونرسمھ  0.001x0.001یر جداااا نعرف قطاع كمرة صغ  لوضع حمل السور فى البلكونات :  خرىأملحوظة  

  't/m 0.25یساوى وزن السور وھو تقریبا   uniformعلى حدود البلكونات  ونخصص لھ حمل موزع 
  
  
 deadوفى حالة الــ     liveفى حالة الــ  )2ads= 0.2 t/mlive lo    (عن وضع احمال البلاطات وھى عبارة  یتم -8
نھ معلوم وزن البلاطة بنفسھ لأضع وزن البلاطة حیث ان البرنامج یحسب ولان (floor cover = 0.15 t/m2)نضع  

  : وذلك من  تخانتھا
Assign → Area loads → uniform (shell)  

 

         
 

 وذلك لتوزیع الحمل على نقط كثیرة وزیادة الدقة فى النتائج یتم تقسیم البلاطات الى اقسام صغیرة - 9
  :ستخدام الأمرثم إھا بإختیار البلاطات المراد تقسیم

Edit → Edit Areas →Divide Area  

mailto:eng_m_z@yahoo.com


       (Sap 2000 ver. 14) 2000شرح برنامج ساب 
 

 eng_m_z@yahoo.comمصر –امعة الزقازیق ج–كلیة الھندسة  - مدرس مساعد بقسم التصمیم الانشائى -محمود زغلل/ المھندسعداد إ         
]

                                 
  

                           
  
  

  ونختار التقسیم بالعدد للبلاطة لعدد من القطع أو تقسیمھا بالمسافات أو تقسیمھا حسب خطوط 
  الشبكة أو عند تقاطعھا مع الكمرات

 
 
  
  
  

التقسیم بعدد القطع فى 
 x ,y اتجاه 

 بأقصى مسافةالتقسیم 
 x ,y فى اتجاه 

بلاطات  عند تقاطع الالتقسیم 
او  gridمع خطوط الشبكة

مع خطوط تقطع البلاطة أو 
  .مع نقط على حدودھا

تقسیم البلاطات بخطوط 
 مرسومة
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  : ل البلاطات الناتج بعد التقسیم بالشكل التالى فیكون شك

  

 
  

مع البلاطات التى تم   continousیتم تقسیم الخطوط الى اقسام صغیرة بحیت تكون  - 10
 وذلك بأختیار كل الكمرات والنقط وأستخدام الأمر تقسیمھا من قبل

Edit→Edit lines→ divide frames→  
Break at intersections with selected joints and frames ونختار منھا 
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  حیث انھ یعمل    العاشر قیما فوقویمكن التغاضى عن ھذه الخطوة بشرط ان نعمل على الأصدار 
Automatic sub-divisions  للعناصر الخطیة عند اى نقطة علیھا ویعمل بطریقة صحیحة اما اذا كنا نعمل

  ر كل العناصر ونخصص لھاقل من ذلك فأنھ یجب ان نختاأ sap على اصدار 
Assign →frame →Automatic subdivisions     

  ونختار التقسیم عند اى نقطة على العنصر او عند تقاطعات العناصر كما  بالشكل 
    

      
  
  
  
  
  
  
  
  
  
  
  

  .للكمرات كلھا ما عدا الكمرات الدائریة إن وجدت torsionیتم تحریر  - 11
   :وذلك من القائمة 

Assign →frame→Releases/partial fixity 

  
  runثم عمل   save یتم حفظ الملف - 12

 
  :ملاحظات ھامة جدا 

  .للبلاطات كلھا فى نفس الاتجاه لأنھ یعتمد علیھا المخرجات   local axisتأكد أن المحاور المحلیة ** 
  .ولونھ أزرق فى اتجاه واحد للسقف كلھ وھو لأعلى    local Axis 3تأكد من أن ** 

 اك بعض الأجزاء مقلوبة یمكن عكس المحور الثالث لھا باختیارھا ثم عملإذا كان ھن
Assign →Area →Reverse local 3 

أما في حالة الحاجة لدوران المحاور المحلیة حول المحور الثالث بزاویة لنضبطھا مع باقى السقف فنختار 
  :الجزء المراد دوران محاوره ثم 

Assign →Area → local Axis 
  okالزاویة التي ترید الدوران بھا  ثم ثم وضع 
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  :المخرجات 
  

 حسب الكود المصرى   (Dead+live )* 1.5وھى ھنا تساوى   ultimateیتم عمل حالة تجمیع للقوى 
  : وذلك من القائمة  0.75اقل من  لأن قیمة الحمل الحى صغیرة بالنسبة للحمل الثابت

Define→ load combinations  
  addمن  1.5یساوى   scaleبــ  ثم نضیف كل حالة

  

 
  
  

  .وھى تمثل حمل العمود من الدور الواحد للمبنى   reactionsیتم الحصول على *  
  

 Display→show force/stressesیتم الحصول على شكل العزوم على البلاطات من القائمة * 
→shells  
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  )1للتسلیح فى اتجاه (حمر الأ  local axis 1ھو العزم فى إتجاه المحور   M11 حیث 
  )2للتسلیح فى اتجاه (الأبیض   local axis 2ھو العزم فى إتجاه المحور    M22      و

  
فرش (عادة ما تكون صغیرة ویكفى أن نضع شبكة حدید واحدة    solid slabولكن ھذه القیم بالنسبة لــ 

 البحر بالنسبة للبحور الداخلیة  5/1ویتم تكریب نصفھا عند الكمرات عند  6Ø10/mسفلیة ) وغطاء
 .البحر للبحور الخارجیة 10/1عند تكرب و وتمتد الى ربع البحر الأكبر المجاور

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

1 

2 

M11 M22 
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  :و قوى القص   الأھم ھنا ھو العزوم على الكمرات
33 & Shear22 Display → show force/stresses → frame/cable Moment 

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

 display- tablesعلى الركائز فى جدول من   reactionsیتم اظھار قیم 
  .ثم ننسخھا الى برنامج الاكسل ونصمم الاعمدة  jointsللنقط   outputثم نختار المخرجات 

 الشكل بدون قیم إظھار

 قیمال وعلیهالشكل  إظھار

 frame elementsالقوى الداخلیة فى 

 مقیاس الرسم

Ultimate 
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  File → Export to Excelولتصديرھا الى أكسل نختار     

  
  
  

نختار الحالة التى 
 نرید نتیجتھا
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Slabs of FlatAnalysis  
  

 labsS Flat  فقط وقد یكون بھا كمرات طرفیة  أعمدةھي البلاطات المرتكزة على
Marginal beams  . تخانة البلاطة أكبر من او یساوى (15 cm)    إما أن تكون

  .  مستطیلة أو دائریة أو مشطورة
  
  
  
  
  
  
  
  
  
  
  
  
  

  
  
  
  
 
 
 
 
 
 
 
 
  
  
  
  
  
  
  
  
  
  
  
  
  
  

Flat Slabs 

90 o 

5m 

mailto:eng_m_z@yahoo.com


       (Sap 2000 ver. 14) 2000شرح برنامج ساب 
 

 eng_m_z@yahoo.comمصر –امعة الزقازیق ج–كلیة الھندسة  - مدرس مساعد بقسم التصمیم الانشائى -محمود زغلل/ المھندسعداد إ         
]

 
 
  
  
 
 
  

  :الخطوات
 .و البلاطاتند أى تقاطع  للكمرات أع Y -Xفى المستوى   gridsیتم عمل  - 8
 defineیتم تعریف قطاع الكمرات والبلاطات التى سنحتاجھا من قائمة   - 9

Frame sections & Area sections   

           
  

 frame/cable–raw Dیتم رسم الكمرات باستخدام الأمر 
  dummyأو وھمیة     invertedبة أو مقلو    projected سواء كانت الكمرات ساقطة             

  continuousلكل الكمرات المرسومة لتكون    divide frames ثم عمل 
 
 
 
 
 
 
 
 

 
ویجب قبلھا اظھار  Area -drawیتم رسم البلاطات بینھا باستخدام الأمر  -10

 .لرسم عنصر بین نقطتین 

    grid lineلرسم عنصر على 

فى باكیة محصورة  bracingلرسم 
 . grid linesبأربعة خطوط من 

  فى باكیة  secondary beamsلرسم 
  یسیة او رسم اعصابمحصورة بكمرات رئ

 سلم حول ال تعریف قطاع الكمرات
 Define frame section , 

Add rectangular  تعریف قطاع البلاطة  
Define Area section , 

Add shell 

  membraneالتخانة فى 
  ثابتة Bending   الــ وفى 

Floor height = 3 m 

wall thickness = 12 cm
ts= 20 cm
 LL=0.4 t/m2 
Assume floor covering = 0.15 t/m2 
Equivalent wall loads on slab = 0.2 t/m2 

S20 

0.2 
0.2 
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Fill objects   من القائمةView →set display options  وكذلك اظھار
 :كما بالشكل  Area local axesالتى سترسم  المحاور المحلیة للبلاطات

 
  
  
  
  
  
  
  
  

خط على حدود  البلاطة   باختیارویتم رسم البلاطات الدائریة على شكل مثلثات بسھولة 
  : لھا ثم عمل    radiusالدائریة یصلح لأن یكون 

Edit→ Extrude→Extrude  line to Area 
  زاویة كل قطعة وعدد القطعمركز دوران الخط و وإدخال radialثم اختیار 

  
  .تماما   continuousوعند الرسم للبلاطات  یجب ان نراعى أن تكون البلاطات متصلة 

  
  :مثلا

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

    لرسم  بلاطة بأربعة نقط 

    بلاطة مستطیلة بنقطتینلرسم 

في باكیة محصورة   بلاطةلرسم 
 . grid linesبأربعة خطوط من 

 خطأ

 صح

  صح خطأ
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 hinged  estraints Assign →joint → R  یتم وضع الركائز مكان الأعمدة -11
ونضعھا تقریبا فى منتصف الحائط مع ربط   hingeعلى انھا   shear wallمع ملاحظة وضع ركیزة الحائط المسلح  

  bodyثم اختیار  Assign joint constraint النقط على طول الحائط كلھ مع ھذه الركیزة بأختیارھم كلھم وعمل 
   Add new constraintثم  اضافة قید جدید من 

  
 

 Bodyه ضربھ الطویل بـــ یربط بنقطة بجواره فى اتجا   flat slabویفضل ایضا ان اى عمود فى 
constraint  مع مراعاة انھ فى كل مرة نعملAdd new constraint   لكل عمود على حدة.  

  
موضوع فیھا   deadنجد حالة واحدة اسمھا  Define load patterns تعریف حالات الأحمال من القائمة  یتم -12

self weight multiplier=1   ثم نضیف حالة  طات والكمرات فى الأعتبار فنتركھا كما ھى لیأخذ وزن البلا
 : كما بالشكل التالى     .own wtولا نضع فیھا   liveونوعھا   liveتحمیل جدیدة اسمھا 

 

  
  

فى  وھى حمل الحوائط یھاالأحمال علیتم اختیار الكمرات الموجود علیھا حوائط  وھى كمرات السلم ونضع   -13
  : deadالحالة  
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W wall = γ brick *h wall*t wall = 1.8*2.5*0.12 = 0.6 t/m'  
  :ونضع الحمل من القائمة 

Assign →Frame loads →distributed  
 

 
  .فلا نضع وزن الكمرات  مع ملاحظة أن البرنامج یأخذ  وزن الكمرة من نفسھ

  
 'م/طن 4الى  2كمرة السلم التى فى منسوب الدور علیھا احمال اضافیة من السلم تقریبا من :  ملحوظة ھامة جدا

متر فیكون تقریبا   5.25مثلا عندنا ھنا طول السلم كلھ   (L /2*1.2)وھى  تساوى فى حالة السلم القلبتین تقریبا 
   't/m 3.15 = 5.25/2*1.2الحمل الأضافى الذى سیوضع على الكمرات القصیرة فى السلم ھو 

لكن یمكن رسمھا ھنا    planذا الــ المفروض الا تكون موجودة فى ھ أما كمرة نصف الدور فھى اصلا 
  . 't/m 3.15ونضع علیھا احمال الحائط وایضا حمل السلم الاضافى   simple beamفقط لأنھا تعتبر 

  
  
 deadوفى حالة الــ     liveفى حالة الــ  )2ads= 0.4 t/mlive lo    (عن وضع احمال البلاطات وھى عبارة  یتم -8
وزن ولانضع وزن البلاطة حیث ان البرنامج یحسب  (floor cover + walls = 0.15+ 0.2= 0.35 t/m2)نضع  

  : وذلك من  نھ معلوم تخانتھاالبلاطة بنفسھ لأ
Assign → Area loads → uniform (shell)  

 

         
 

لتوزی  ع الحم ل عل ى نق ط كثی رة وزی ادة الدق ة ف  ى        ی تم تقس یم البلاط ات ال ى اقس ام ص غیرة       - 13
  :ستخدام الأمرثم إبإختیار البلاطات المراد تقسیمھا  كوذل النتائج

Edit → Divide Area  

0.35 0.4 
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  ونختار التقسیم بالعدد للبلاطة لعدد من القطع أو تقسیمھا بالمسافات أو تقسیمھا حسب خطوط 
  الشبكة أو عند تقاطعھا مع الكمرات

  

 
 
  
  

التقسیم بعدد القطع فى 
 x ,y اتجاه 

 بأقصى مسافةالتقسیم 
 x ,y فى اتجاه 

طات  عند تقاطع البلاالتقسیم 
او  gridمع خطوط الشبكة

مع خطوط تقطع البلاطة أو 
  .مع نقط على حدودھا

تقسیم البلاطات بخطوط 
 مرسومة
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  .للكمرات كلھا ما عدا الكمرات الدائریة إن وجدت torsion یتم تحریر - 14

   :وذلك من القائمة 
Assign →frame/cable →Releases/partial fixity  

  
  

  بطریقة أدق  وأفضل من السابقة وذلك بأختیار كل الكمرات وعمل   TORSIONیمكن عمل تحریر للــ 
Assign →Frame/cable →property modifier  

  :كما بالشكل  torsion constant امام معامل الألتواء   0.0001قیمة صغیرة جدا  ثم وضع

 
  runثم عمل   save یتم حفظ الملف - 15

 
  :ملاحظات ھامة جدا 

  .للبلاطات كلھا فى نفس الاتجاه لأنھ یعتمد علیھا المخرجات   local axisتأكد أن المحاور المحلیة ** 
  .ونھ أزرق فى اتجاه واحد للسقف كلھ وھو لأعلى ول   local Axis 3تأكد من أن ** 

 إذا كان ھناك بعض الأجزاء مقلوبة یمكن عكس المحور الثالث لھا باختیارھا ثم عمل
Assign →Area →Reverse local 3 

أما في حالة الحاجة لدوران المحاور المحلیة حول المحور الثالث بزاویة لنضبطھا مع باقى السقف فنختار 
  :راد دوران محاوره ثم الجزء الم

Assign →Area → local Axis 
  okثم وضع الزاویة التي ترید الدوران بھا  ثم 
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  :المخرجات 

  
حسب الكود   (Dead+live )* 1.5وھى ھنا تساوى   ultimateیتم عمل حالة تجمیع للقوى 

  من القائمة وذلك  0.75اقل من  لأن قیمة الحمل الحى صغیرة بالنسبة للحمل الثابت المصرى 
Define→ load combinations  

   addمن  1.5یساوى   scaleثم نضیف كل حالة بــ 
  

 
  
  

  .وھى تمثل حمل العمود من الدور الواحد للمبنى   reactionsیتم الحصول على *  
  

 Display →show force/stressesیتم الحصول على شكل العزوم على البلاطات من القائمة * 
→shells 
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  )1للتسلیح فى اتجاه (الأحمر   local axis 1ھو العزم فى إتجاه المحور   M11 حیث 
  )2للتسلیح فى اتجاه (الأبیض   local axis 2ھو العزم فى إتجاه المحور    M22      و

    
  
  
  
  
  
  
  
  
  
  
  
  

  
  

        
  
  
  
  
  
  

1 

2 

M11 M22 
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 Display→ tablesعلى الركائز فى جدول من   reactionsیتم اظھار قیم 
  .ثم ننسخھا الى برنامج الاكسل ونصمم الاعمدة  jointsللنقط   outputثم نختار المخرجات 

  
  
  

  

نختار الحالة التى 
 نرید نتیجتھا
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Mur=3.5 t.m

Asmin=0.2*20=4 cm2 = 6  10/m'

Mur -VE=As*fy*d*j =6*1.13*3600*17.5*0.81/10=3.5 t.m/m'

using  6  12/m' top in both directions

combo ultimate Ultimate

5

using  6  10/m' bottom in both directions

Mur +VE=As*fy*d*j =6*0.785*3600*17.5*0.81/10=2.4 t.m/m'5
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 فتظھ ر    Rangeداخ ل ال  ـ  أظھار قیم العزوم فى الاتجاھین للبلاطة فى المناطق التى تق ع  یتم
  بلون ثابت  Rangeالمناطق التي أقل من الــ   - 1

  .بألوان كثیرة  Rangeخل الــ والمناطق دا  -2         
   .بلون ثابت لكنھ غیر اللون الأول  Rangeوالمناطق اكبر من الـ   -3         

  
  .فقط ولا تحتاج  حدید أصافى ةالمجموعة الأولى یكفیھا الشبكة الأساسی  
  .والمجموعة الثانیة تحتاج نصف شبكة إضافة إلى الحدید الرئیسي  
ولكن یجب التأكد من لأساسیة ج إلى شبكة حدید إضافة إلى الشبكة اوالمجموعة الثالثة تحتا 

  .ید عن مقدار تحمل شبكتینزأن العزوم فى ھذه المجموعة لا ت

  
  

-5.25 -3.5 
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M11 +ve 

 

 
M22 +ve   
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M11 –ve 

 
 

  
M22 –ve  
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  dashedوالتسلیح العلوى یظھر بخط   solidالتسلیح السفلى یظھر بخط 

  
  
  
  

  

6
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Circular tanks  
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  :الخطوة الأولى 
  .واضبط الوحدات طن ومتر  sap2000افتح برنامج 

  :الخطوة الثانیة  
حیث سنقوم   x , zثم ادخل خطوط الشبكة فى   grid onlyواختار   new modelافتح ملف جدید 

  :بالشكل برسم الخطوط الراسمة للخزان فقط وھى كما 

8.00

5.00

4.00

5.00

5.00

5.00

5.00

2.002.00
1.00

2.00
2.00

x

z 2.00

2.00
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    XZثم نظھر المستوى 
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  frame section –defineنعرف القطاعات للكمرات المطلوبة وللعمود من القائمة 

1 - Rectangular horizontal beam 35*80 cm 
2 - Angle 80*80*35*35 cm 
3 - Rectangular tie ring beam  50x25cm 
4 - Rectangular column 80x30 cm 

  
ولكننا  Asec1ولا نعدل القطاع الموجود  ections s–Area  –defineنعرف قطاع البلاطات من 

   Add new sectionنعرف قطاعات جدیدة 
1 - Dome 12 cm 
2 - Cylinder 30 cm 
3 - Shaft 20 cm 
4 - Cone 30 cm 
5 - Lower  dome 30 cm 

  
 – editنختار نقطة من بدایة المسار الدائرى ونعمل لھا :  لرسم المسارات الدائریة كخطوط

extrude – extrude point to lines  ثم نختارradial   وندخل مركز الدوران والمحور الذى
وزاویة كل   number سندور حولھ وھو یكون المحور العمودى على المستوى  وعدد القطع

  angleقطعة
  

نختار الرواسم وھى الخطوط التى رسمناھا من قبل فى :  لرسم المخروط والاسطوانات والقباب
    edit – extrude – line to Areasثم نعمل لھا   X-Zالمستوى 

 وعدد القطع   Zوندخل مركز الدوران والمحور الذى سندور حولھ وھو محور   radialثم نختار  
number  وزاویة كل قطعةangle  : لاحظ ان عدد القطع لابد ان یكون من مضاعفات عدد

درجة یعنى كل  360لكلیة قطعة  وزاویتھم ا 24الأعمدو ولیكن ثلاثة مرات من عدد الاعمدة یعنى 
  . 360/24زاویة تساوى 

  
  

   section  –Area  –Assignوبعد الرسم نختار البلاطات  ونخصص لھا قطاعھا من 
  
  

ان نراعى ان یكون المحور الثالث الازرق عند الرسم للبلاطات وأ  fill objectsاظھار  یجب
یعنى اللون البنفسجى للبلاطة داخل للخارج من ال  فى اتجاه ضغط المیاه    local axis 3للبلاطات  

  ..واللون الاحمر للبلاطة  ملامس للھواء دائما یكون ملامس لسطح المیاه
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 radial  –replicate  –editنختار العمود المرسوم ثم :     Zلتكرار الأعمدة  الثمانیة حول محور 
  .  360/8كل قطعة وھى وزاویة   7وعدد القطع الجدید وھو   Zوندخل محور الدوران 

  
 edit– نختار نقطة من بدایة المسار الدائرى ونعمل لھا    ring beamsلرسم الكمرات الدائریة 

extrude – extrude point to lines   ثم نختارradial   وندخل مركز الدوران والمحور الذى
  . =angle  360/24وزاویة كل قطعة  number =  24 وعدد القطع    Zسندور حولھ 

  
   Assign –joint patternنختار النقط الملامسة لسطح المیاه كلھا ثم    :لوضع حمل المیاه

  :وندخل معادلة ضغط المیاه وھى 
+DZPressure = c   

  
   c=-1,     D =  ارتفاع المیاه من قاع الخزان لأخره 
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: من  patternضغط حسب  ونضع علیھا أخرىثم نختار كل البلاطات الملامسة لسطح المیاه مرة 

Surface pressure –Area loads –Assign   
 scale =1وندخل 

  
  
  

لأن   M11 , M22بدلا من F11 , F22ونظھر النتائج  على البلاطات   modalثم نحل ونلغى الـ 
  .فقط   normal forceقیمة العزوم تكون صغیرة جدا ومعظم الأحمال تحولت الى 

 Axial ,Shear22 , M33: م والقص والقوى المحوریة على الكمرات یتم أیضا إظھار العزو
  

نختار ھنا الوجھ البنفسجى 
الملامس لسطح المیاه وھو 

Bottom 

 by pattern نختار ھنا 
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axial reing tension or compression in slabs -F11   

  

  
axial vertical  tension or compression in slabs  -F22  
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Axial forces in frame elements ( beams , columns)  
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ms , columns)M33  in frame elements ( bea   
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1.00

0.50

0.50
0.50

0.25
0.50

1.00m

0.32

0.07m

0.25
0.50

0.5m

0.32

0.07m

Internal Beam

External Beam

Live loads = 0.3 t/m2

Covering =0.15 t/m
walls exist on beams = 0.6 t/m'
ts = 7 cm
t = span /25 =800/25 =32 cm 
Rib width = 10 cm

2

Rib spacing = 50 cm

8.0m

5.0m

8.0m

Hollow blocks weight =0.15 t/m
2
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200 ton 120 ton 200 ton 

230 ton 
200 ton 200 ton 

130 ton 

230 ton 500 ton 230 ton 

130 ton 

200 ton 

130 ton 

TOTAL LOADS  FOR COLUMNS = Ri *No. Floors * 1.1   

WORKING loads 

  Raft Foundation 
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من مساحة المنشأ كلھ فیلزم اخذ    2/3عندما تكون المساحة المطلوبة للقواعد المنفصلة اكبر من 

  .  (Raft Foundation )= ( Mat foundation)القواعد كلھا لبشة واحدة 
  

  سم X   10تخانة  اللبشة تقریبا تساوى عدد الأدوار 
  

  :خطوات التحلیل والتصمیم 
  

حسب محاور   Gridsوإدخال الـ  2000یتم الدخول إلى برنامج الساب  -1
  .الأعمدة 

عدد ( متر  1ولیكن   Define – Area --Sectionیتم تعریف قطاع اللبشة  -2
 .سم لكل دور تقریبا 10نأخذ  )ادوار 10الأدوار 

  Gridsبین الـ    Quick Areaیتم رسم البلاطات بأمر  -3
 :متر من القائمة  1/2یتم تقسیم البلاطات إلى أقسام صغیرة لا تتجاوز  -4

Edit –Divide Area 
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  : فیظھر التقسیم بالشكل التالى 

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

  .مع بعضھا   continuousد من أنھا ونتأك
  

 . concentrated loadsیتم اختیار النقط التي علیھا أحمال الأعمدة ونخصص لھا  - 5
     assign – joint loads – forces:من القائمة       

على الأقل نقطتین   shear wallsویجب تقسیم الحمل على عدة نقط على حدود العمود  أو 
  . عزوم كبیرة جدا على البلاطة حتى لا نجد ال

  
  

 P totalلاحظ ان الحمل سیكون ھو حمل العمود كلھ فى جمیع الأدوار 
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P total = Ri * no. floors *1.1 =  

 
 
 
 
 
 
 
 
  
  
  
  
  
  
  

ویتم توصیفھا على انھا   soilیتم بعد ذلك تخصیص الركائز للقاعدة وھى ھنا التربة  - 6
 stiffness موضوعة عند النقط  ولھا كزازة معینة  rings spمجموعة من الـ 

 
  :  springsللـ  stiffnessكیفیة حساب 

العمودى  تجاهالالھا فى فى   stiffnessوقیمة الـ   area springsونخصص لھا نختار كل البلاطات : أولا
  :وتساوىعلى اللبشة 

  :  springللـ   stiffnessنحسب  
  K =B.c *1000  

  
  

                      
 
   

  
  
  
  
  
  

  

  2سم/كجم 1.2ولیكن ھنا مثلا  2سم/قدرة  تحمل التربة  كجم

t /m2   و الناتج یكون بوحدة 

Reaction of col. for one floor (working) 
 

ton 
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Assign→ Area→ Area springs 

  
  
  
  

  run و یتم بعد ذلك حفظ الملف وعمل 
 
  
  
  
  
  
  
  
  

stiffness 

ضغط فقط لأن التربة 
 لا تتحمل الشد

Bottom   لأن
  التربة تحت اللبشة

 springنختار اتجاه الــ 
عمودى على مستوى 

 البلاطة
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  define → load combinationمن القائمة   comboبعد الحل یتم عمل 

  .على البلاطات   Ultimateلأخذ العزوم الــ 
  
  
  
  
  
  
  
  

   factorنختار اسم ثم نضع 
  addثم نضغط  

  
  
  

  :التصمیم 
  

نلاحظ ان العزوم الموجبة اقل بكثی ر م ن    M11 , M22یتم ملاحظة العزوم على اللبشة  
  .العزوم السالبة 

فیتم فرض شبكة تسلیح سفلیة وایضا شبكة تسلیح علویة غیر متساویین لتقلیل الھدر فى 
  ة الواحدة  فى اللبشة للناحی  As minولكن یجب الا تقل عن . الحدید 

As min =0.0015*B*t 
As min =0.0015*100*100 = 15 cm2 

= 6 Ǿ 18 /m'  
  :ونحسب مقدار تحمل العزوم لھذه الشبكة من برنامج الأكسل 

B  عرض
 t(cm) M u (cm)الشریحة

(t.m) c1 c/d j As(cm2) 
bar 

diameter 
(mm) 

no. 
Bars  

 ىعلو 6 22 22.41 0.826 0.125 5.809 60 100 100

 سفلى 6 18 14.94 0.826 0.125 7.11 40 100 100

  
  للشبكة السفلیة      Mu = 40 t.mفیكون  'Ǿ 18 /m 6 فنختار سفلى  

  'Ǿ 22 /m 6 ونختار للشبكة العلویة حدید اكبر من السفلى ولیكن 
Mu = 60 t.m     علویةللشبكة ال  

  
  

 الاسم

factor 
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  :لحساب الحدید الأضافى 

    range مرات  یتم عمل اربع  -
  yوالأخر فى   xاثنین للحدید الأضافى الموجب احدھما فى 

  .ایضا   yوالأخر فى   xواثنین للحدید الأضافى السالب  احدھما فى 
  

1 -  M11 الموجبالسفلى 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
  
  

ونلاحظ ان كل المناطق فى اللبشة اقل م ن الش بكة اى انھ ا لا تحت اج اى اض افى      :  فیظھر الشكل التالى
   xى فى اتجاه سفل

 
 
 
 
 
 
  
  
  
  
  
  
  
  

  الشبكة 1.5 عزم الشبكة 
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2 - M22   فى اتجاه  الموجبالسفلىY  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

  نلاحظ ایضا انھا لا تحتاج 
  أى اضافى سفلى ماعدا عند

  النقط الموجودة اسفل الأعمدة 
  وھى مساحات صغیرة جدا 
  تقع داخل محیط العمود 
  .ویمكن اھمالھا  

  
  
  
  
  
  
  
  
  
  
  
  

  

  الشبكة 1.5 عزم الشبكة 
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3 - M11    فى اتجاه  لبالساالعلويx  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

  الشبكة 1.5 عزم الشبكة 

اتجاه  نصف شبكة اضافى علوي في
x 

 xاضافى علوي في اتجاه  كاملة  شبكة
نصف شبكة اضافى 

 xعلوي في اتجاه 

 كاملة  شبكة
اضافى علوي في 

 xاتجاه 
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4 - M22    فى اتجاه   السالبالعلويY  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

  الشبكة 1.5 عزم الشبكة 

 Yنصف شبكة اضافى علوى 
 Yنصف شبكة اضافى علوى 

 Yاضافى علوى  كاملة شبكة

نصف شبكة  Yضافى علوى نصف شبكة ا
 Yاضافى علوى 
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  .لاحظ ان الحدید الأضافى العلوى فى منتصف البحر بین الأعمدة  ** 

  
 60نطقة المطلوب فیھا الحدید م ع اض افة ط ول رب اط     طول الحدید الأضافى العلوى یساوى طول الم**

 .من طول البحر بین العمودین  0.7قطر السیخ من كل ناحیة وبشرط الا یقل عن 
   

فى حالة الحاجة لأضافى سفلى سیكون تحت الأعمدة ویجب ان یمتد من ك ل ناحی ة عل ى الأق ل رب ع      ** 
  .البحر المجاور 
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RAFT  Reinforcement 
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 Stairsالسلالم 
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  الحلزونیة  السلالم
StairsHelical  
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Analysis of buildings due to Lateral loads   
(Wind and Earthquakes)  

  التحلیل الأنشائى للمنشآت تحت تأثیر الأحمال العرضیة 
  )الریاح والزلازل( 

  
  :الأھداف 

تح ت ت أثیر     D-3ف ى ھ ذا ال درس بعم ل تحلی ل انش ائى ف ى        ن شاء االله إسوف نقوم 
والمف  روض ان حص  ل ف  ى . الأحم  ال الأفقی  ة وھ  ى إم  ا أن تك  ون الری  اح أوال  زلازل  

م  ن  الناتج ة   axial forces و   Moments المحوری ة  النھای ة عل ى الع زوم والق وى     
ل  ى ان  ھ یج  ب أخ  ذ  وی  نص الك  ود المص  رى للأحم  ال ع . أحم  ال الری  اح أو ال  زلازل  

  .التأثیر الأكبر على المنشأ سواء الریاح او الزلازل ولا یتم جمع الریاح او الزلازل
  
  

  :المثال التطبیقى 
  

  .متر  8متر وبقیة الأدوار  5عندنا منشأ ثمانیة طوابق أرتفاع الدور الأرضى 
  

  .سوف یستخدم المنشأ للأغراض السكنیة 
  

وھ ى ف ى خریط ة    ( زیق بجمھوریة مصر العربیة  وسوف یتم انشاؤه فى مدینة الزقا
     (Zone 3)الزلازل تتبع المنطقة الزلزالیة الثالثة 

  
    B/C= 1.5 kg/cm2وجھد التربة تحت منسوب الأساسات 

  
وسوف یتم مقاومة أحمال الریاح والزلازل عن طریق الح وائط الخرس انیة المس لحة    

shear walls  اھم فى مقاومة القوى العرضیةبالأضافة الى الأعمدة التى تس.  
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90
o

  
  

  .وموجود ملف الساب لھ   Flat slabsھذا السقف تم حلھ من قبل فى شرح البلاطات الــ 
  

عل ى احم ال     Excelولیكن انن ا ص ممنا الأعم دة تص میما مب دئیا عل ى الأكس ل        
Dead , Live  .  

  سنتیمتر 30x80وكانت القطاعات للأعمدة 
 مترسنتی 250*25ت كان Shear walls والحوائط
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  الخطوات الأساسیة لحل المنشأ
  

  : الخطوةالأولى
  supportsبلاطات وكمرات وموضوع علی ھ الرك ائز     X-y  planعندنا منشا مرسوم فى 

وتم تص میم الأعم دة   . ومحلول نتیجة ھذه الأحمال الرأسیة   Dead , Liveوعلیھ الحمال 
ى برنامج آخر  وحساب ابعاد الأعمدة وتس لیحھا مب دئیا   أو على أ  Excelعلى برنامج  

.  
  
حی  ث ان الأص  دار العاش  ر      Sap2000 V. 14نق  وم بف  تح ھ  ذا المل  ف بإس  تخدام     -

والث  انى عش  ر بھ  م خط  أ عن  د ادخ  ال احم  ال ال  زلازل أو الری  اح ف  ى شاش  ة تعری  ف      
  .الأحمال
المص رى ال ذى   حس ب الك ود     (Dead + 0.25 live)تس اوى    combinationونعم ل  

ینص على أن مثل ھذه المنشآت التى تستخدم للسكن یتم حساب أحمال الزلازل عل ى  
  .قیمة الحمل الحى على المنشا   1/4أساس الحمل الثابت بألضافة الى 

  
  

  joint reactionsنحسب وزن الدور الواحد من عن طریق اظھار جدول بھ  -
ث  م اختی  ار   Display→ tablesوذل  ك م ن القائم  ة    Z  forceف ى اتج  اه  

joint output  كما بالشكل :  
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 188.6فنجمعھا تساوى   Zفى اتجاه   reactionsفتظھر الشاشة التالیة بھا   okثم  

  طن 
  
وذلك لأخذ وزن الأعمدة     reaction *1.1 وبذلك یكون وزن الدور یساوى مجموع

  .فى الأعتبار 
Weight of floor = 1.1*188.6 = 207 ton  

  
  
  

على الشیت الجاھز الذى صنعناه    Excelندخل الى برنامج  :الخطوة الثانیة 
وھما متساویین   Yو   Xلحساب احمال الزلازل على المنشأ على كل دور فى اتجاه 

  .بالنسبة للزلازل
  
  

 Dead + 0.25 liveنختار الحالة 
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EARTHQUAKE FORCES ACCORDING TO EGYPTIAN CODE 2008 
BY Eng. Mahmoud Zaghlal Jan. 2010 

INPUTS:  
 

  

SOIL TYPE A,B,C or D  = C 

ZONE 1,2,3,4,5A or 5B = 3 

REDUCTION FACTOR (R) = 5 

Total Weight of building (TON)= 1656 

TOTAL HEIGHT of building (m)= 26 

IMPORTANCE FACTOR 1 or 1.25= 1 

  
OUR SOIL S TB TC TD   

C 1.5 0.1 0.25 1.2   
       

TYPES OF SOIL S TB TC TD   
A 1 0.05 0.25 1.2   
B 1.35 0.05 0.25 1.2   
C 1.5 0.1 0.25 1.2   
D 1.8 0.1 0.3 1.2   

REDUCTION FACTOR (R) = 5 1     
       

ZONE 1 2 3 4 5A 5B 
ag 0.1 0.125 0.15 0.2 0.25 0.3 

WEIGHT (TON)= 1656           

ag= 0.15      

H= 26 m     

T1=Ct(H)^3/4= 0.575705 seconds     

IMPORTANCE= 1      

CASE1 Sd(T)= -0.065889     

CASE2 Sd(T)= 0.1125     

CASE3 Sd(T)= 0.048853     

CASE4 Sd(T)= 0.10183     

FINAL Sd(T)= 0.048853      

λ = 1 
  

   

Total base shear      Fb   = 80.9008 ton      

یة 
عنا

م ب
لقی

ه ا
ھذ

ل 
خا

 اد
جب

ی
رى

ص
الم

ل 
حما

الأ
ود 

ب ك
حس

 
20

08
 

ھنا یظھر البرنامج القوة الزلزالیة  
  .المنشأ بالطن الكلیة المؤثرة على
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DISTRIBUTION OF EQ FORCES   توزیع احمال الزلزال على الأدوار    
   

       

hi (m) from base level Wi (TON) hi.Wi Fi (TON)     For X or Y directions 
 

5 207 1035 3.262129273    
8 207 1656 5.219406837    
11 207 2277 7.1766844    
14 207 2898 9.133961964    
17 207 3519 11.09123953    
20 207 4140 13.04851709    
23 207 4761 15.00579466    
26 207 5382 16.96307222    
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       
       

SUMMATION 1656 25668 80.90080597    

  
  
  

ندخل فى ھذا العمود 
منسوب كل دور مقاسا 
من منسوب الأساسات 

 ......تراكمیا بالمتر 

ندخل 
فى 
ھذا 

العمود 
وزن 

كل 
دور 

بالطن 
...  

البرنامج 
یحسب ھنا 
زلزالیة القوة ال

المؤثرة على 
كل دور حتى 

ندخلھا الى 
برنامج الـ 

Sap2000 

  .بالطن  لقوة الزلزالیة الكلیةاالبرنامج یحسب ھنا    .ھ بالطن البرنامج یحسب ھنا وزن المنشا كل 
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  :الخطوة الثالثة 
  

مع ملاحظة أن   Yأو   Xنحسب أحمال الزلازل من برنامج أحمال الزلازل سواء فى اتجاه
  .والعكس صحیح   Yجھة الموازیة للاتجاه تؤثر على الوا  Xالقوة فى اتجاه 

  
  
  
  
  

    
  

  

 
  
  

Wx 

Wy 

  Wyقیم   Wxقیم  
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  :الخطوة الرابعة
  

التى قد نكون   constraintsمرة أخرى ومسح   sap2000 v14یتم الرجوع الى برنامج 
 :وذلك باختیار المنشأ كلھ ثم   plan X-Yاستخدمناھا فى 

Assign →Joint →constraints  ثم اختیارNull  ثمok 
  

  :الخامسةطوة الخ
  

وھو ارتفاع الدور  ,متر  5لأعلى مسافة   zنقوم بأختیار المنشا كلھ ثم تحریكھ فى اتجاه 
  .الأرضى

Edit →Move  
 وندخل 

0  ∆x 
0  ∆y 
5  ∆z 
    

  
  :السادسةالخطوة 

  
حتى یمكننا التنقل بین المستویات المختلفة لأسفل ولأعلى   Zنقوم بعمل خطوط شبكة فى اتجاه 

    Edit grid modify gridبالماوس یمین ثم   clickل  وذلك بعم
  Zفى اتجاه   Spacingوندخل القیم التالیة بالنظام الــ 

 
Spacing  Grid ID  

5   
3    
3   
3  
3  
3  
3  
3  
0   
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  :السابعةالخطوة 
  

 ونقوم بأختیار النقط التى عندھا الركائز  ثم عمل  Z=5عند    X-Y planنظھر المستوى 
Extrude    فى اتجاهz   متر  لزرع أعمدة الدور الأرضى  5لأسفل مسافة.  

Edit →Extrude →point to line →Linear  
 وندخل 

0  ∆x 
0  ∆y 
-5  ∆z 
1 Number 

  .حیث یمكن تغییره بعد ذلك  propertyونختار أى قطاع من 
  

  :الثامنةالخطوة 
  

لأعلى   zفى اتجاه    Extrudeعمل  ثم previous نقوم بأختیار النقط  مرة أخرى من  
  .متر  لزرع أعمدة الأدوار العلویة السبعة الباقیین  3مسافة

Edit →Extrude →point to line →Linear  
  :وندخل القیم التالیة

 
0  ∆x 
0  ∆y 
3  ∆z 
7  Number 

  .حیث یمكن تغییره بعد ذلك  propertyونختار أى قطاع من 
  
  

  :التاسعةالخطوة 
  

 Fixedونختار النقط ونخصص لھا ركائز  Z=0عند   X-Y planمستوى ندخل ال
Assign → joint → restraints  

  
  :العاشرةالخطوة 

  
ونكرره ) كمرات وبلاطات ( ونختار بالماوس السقلاف  Z=5عند  X-Y planندخل المستوى 

  .مرات  7متر عدد  3بمسافة   Zفى اتجاه 
Edit →Replicate →Linear  
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  :التالیة وندخل القیم
 

0  ∆x 
0  ∆y 
3  ∆z 
7  Number 

  
  :الحادیة عشرالخطوة 

  :لرؤیة ضرب الأعمدة ونخفى البلاطات   Extrudeنظھر العناصر مجسمة من 

  
  

  :من   X-yولكن ننظر فى   D-3ثم نظھر المنشأ فى 
View→ set 3-D view →X-y  

  تساوى صفر   Apertureونضع زاویة 
  

  :الثانیة عشرالخطوة 
تار الأعمدة بالماوس من الشمال الى الیمین ونتأكد اننا قمنا باختیارھم من شریط المعلومات نخ

  .السفلى فى البرنامج
    Assign →frame →section: ثم نخصص لھا القطاعات من 

ثم فى   Xوندخل ابعاد العمود فى اتجاه   Add new propertyثم نضیف قطاعات لھا من 
  Yاتجاه 

  
  
  
  
  X 

Y 
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  : ظةملحو
بالماوس من الشمال الى ( فى حالة الحاجة لتغییر ضرب عمود ما نقوم بأختیاره بنفس الطریقة 

  :ثم عمل ) الیمین
Assign →frame→ local axes  

  .ووضع الزاویة التى تریدھا

  
  
  لبلاطات والكمرات حسب الكود المصرى اللأعمدة و  stiffnessیجب أن نقلل     

    I eff = 0.5 Ig:للكمرات 
  I eff = 0.25 Ig:  للبلاطات 

 I eff = 0.7 Ig:  للأعمدة وحوائط القص  
  :أى أننا نختار كل الأعمدة وحوائط القص 

Assign →Frame→ property modifier 

 
  

 0.25والبلاطات أیضا   0.5وھكذا الكمرات 
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  للبلاطات

  
  
  

  :الثالثة عشرالخطوة 
حتى یمكننا أن نضع علیھا   diaphragmsثم نخصص لھ   select Allنختار المنشأ كلھ 

  :احمال الزلازل والریاح بعد ذلك 
Assign→ joint→ constraints  

.    Z constantونجعلھ فى اتجاه    Add new constraintثم   diaphragmsثم نختار 
  : ویجب أن نعلم على الأختیار السفلى وھو 

Assign different diaphragms to each (Z) level.  
 OKثم 
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  :الرابعة عشرالخطوة 
  

   Define → load patterns: نعرف حالات تحمیل من القائمة 
  :ثم نضیف الحالات التالیة

  
 

    :ثم نختار كل حالة تحمیل أفقیة سواء كانت ریاح أو زلازل ونضغط على یمینھا  
Modify Lateral Load Patterns  
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عھا عند الدیافرامات التى عرفناھا من قبل  مع مراعاة وندخل القیم للزلازل والریاح حسب ارتفا
وقد تكون مزاحة یمینا أو یسارا بعض    center of Massأن احمال الزلازل توضع عند 

مثل الأكواد   0.05الشىء وقد أفترض الكود المصرى ازاحة نسبیة من عرض المنشا تساوى 
ومرة اخرى   e = 0.05حالتین للزلازل مرة العالمیة الأخرى ولذلك فإننا قد عرفنا فى كل اتجاه 

e = -0.05   سواء فىX   أوY  .  
  
  
  
  
  
  
  

  
  

  . sap2000أما أحمال الریاح  فإنھا توضع أوتوماتیكیا  فى منتصف الواجھة فى الــ 

  

e = -0.05 

e = 0.05 
Mass center 

EQx2 

EQx1  
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  :الخامسة عشرالخطوة 
  

    Dead ,live , Modalلجمیع الحالات ماعدا   Runثم عمل   Saveنقوم بحفظ الملف 
  

  :السادسة عشرالخطوة 
  

  
لحساب أقصى عزوم وقوى على العمدةى والحوائط الخرسانیة   combinationنعمل تجمیعة 

  :من   Shear wallsالمسلحة 
Define→ load combinations→ Add new combo  

یعنى أنھا ستأخذ اقصى قیم من مجموعة   Envelopeونوعھا   Maxونضع لھا اسم مثلا 
  :الات التالیة الح

  
لان الكود المصرى یحسب أحمال الزلازل   1.4أدخلنا ھنا الزلازل كلھا مقسومة على 

Ultimate   لتحویلھا الى   1.4یعنى لزم نقسمھا علىWorking   ومقارنتھا بأحمال الریاح.  
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  التى عرفناھا سابقا   MAXالـــ   Comboللــ    Framesــظھار العزوم للإب قومنثم 
→M22  
→M33 

             →Axial forces  
  .ولرؤیتھا بوضوح نقوم باخفاء البلاطات

                 
  
  
  

على احمال الــ   shear wallsونقوم فى النھایة بتصمیم الأعمدة والحوائط الخرسانیة المسلحة 
Dead , Live   القدیمة بالأضافة الى الأحمال الجدیدة من اقوى الأفقیة...  

  
  
  
  
  
  
  
  
  

M33 22M 
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النسخة   2008بعض الأجزاء الھامة فى الكود المصرى للأحمال لسنة 

  النھائیة 
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